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Introduction 
Tips and Tricks for Autodesk Building Systems is an interesting topic to try to organize. I have 
broken this class down into roughly three main topics 
The toolkits of ABS – ACAD tools, ADT tools, ABS tools takes a look at some of the common 
tools that might be overlooked as you migrate into the 2004 environment. 
Working with the ABS objects is a section that will cover just working with the objects 
provided with the software. Most of this section will be familiar to anyone who has been working 
with ABS, but I put it in here for those new to the software. 
Integrating and Implementing ABS Tips – Working in the BIM world is a discussion about 
how to make use of software that presents you with a new paradigm. Your office has a process 
that it goes through for any job. ABS has an “apparent” process that may not fit with the way 
your office works. How do you resolve these conflicts 
Catalogs, Parts Tips and Tricks is a group of thoughts about how to get the most out of the 
parts that are supplied with the software, and what happens when the part you are looking for 
does not exist. 
 

The toolkits of ABS – ACAD tools, ADT tools, ABS tools  
Autodesk Building systems is a kit of tools to help you get your job done more efficiently. If you 
look at the kit of tools that are provided with ABS, you not only have the standard ABS tools, but 
you also have a drawer full of ADT tools and another drawer full of ACAD tools as well. With the 
release of 2004, the interface changed. Many of the tools are buried in catalogs and you must 
know where they are in order to use them. The first part of this section lists a few ideas about 
how to tame the wilderness of the 2004 environment. The section takes a look at some of the 
tools you have access to, but may not understand where they are stored, or how they are useful 
to you. 
 

The 2004 Environment: 

Maximize Your Desktop Real Estate Investment 

Palettes and Flyouts: 

 

There are many different toolbars in ABS. The Tool Palettes, DesignCenter, 
Project Navigator and Properties all compete for the valuable desktop real 
estate. If you use the minimize button on these flyouts, getting anywhere 
near them when you are working and they are in your face.  

1. Set the flyouts to Auto-Hide 

                        

2. Bring the edges of the ABS window in slightly from each side 

3. Move the flyout palettes out to the edges of the screen.  

You should now have full access to your drawing without the flyouts 
covering up your work when you are at the edges of the drawing. 

 

Tool Palettes 

There was an extension Tool Palettes Extension that everyone with ABS has access to. This 
extension allows you to customize the palettes to break them down by discipline so that you 
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don’t have twenty palettes at once to sort through. The extension is downloadable from 
autodesk’s Subscription page 
http://pointa.autodesk.com/local/enu/portal/vip/members/index.jsp 

  

 

You can also control which tool palettes are 
installed by manipulating one of the paths in the 
options page. On the File tab of the options page 
is a path to the XML that controls the Tool 
Palettes – you can control this variable with the 
Options>Profiles and set a profile switch to set 
these paths for you. Once the profile is made use 
the /p switch to make a set of shortcuts load 
these profiles. 

 

 

While still in the Options page – here’s an odd thought. 
Personal preference when working with ABS is a setting for the otrack variable.  This setting is on 
the Drafting tab of the Options as “Alignment Point Acquisition. I like to set this to Shift to 
Acquire. This lets me utilize otrack without getting all the side end points in the way. Useful for 
adding duct, cable tray or pipe in three dimensions while looking at the plan view. 
 
 

Tools from the Common Workbench. 

This section covers some of the common tools that you can pull out of the common tool kit 

Structural Tools: 
From the structural Member Catalog 
Browse to find the right size 
Double click to make a member style in the current drawing. 
Drag from style manager if you want tool. 
Other: in the Stock Tool Catalog there are some Bar joists – these are just styles that have been 
“Toolized” for you to use 
 
Interference checking will create the red interference mark between the building systems object 
and structural members. 
 
Make sure that you have at least one “beam” tool on a palette somewhere. Even if you do not 
have a structural drawing with the 3D objects, you can create one for interference checking fairly 
quickly with the tools provided. Right clicking on a beam tool will give you the option to apply tool 
to linework. This is the 2004 way to convert lines to structural members. 

Custom Command Tool 

Other tools: Most of the tools in ABS are custom commands you can get a generic custom 
command tool from the Autodesk Architectural Desktop Stock tools catalog on the second page of 
the General Purpose Tools>Helper Tools. 
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Masking Blocks 
A masking block is one of the underdogs of the object realm. A masking block is an object that 
will hide any AEC Object that you tell it to. It is analogous to a wipeout from express tools, but is 
designed to work with the AEC objects. A masking block can be created from any closed polyline, 
and can contain additional graphics. The example I will show you is how to create a break line for 
a single line pipe representation. 
1) Create 3 polylines for the graphics. 
Create two break lines and a closed polyline that will be the actual bounds of the break mark. I 
created all of this on layer 0 – and then used the display representations of the masking block 
definition to assign layers to these sub-objects 
2) Launch Style manager and create a new “Multipurpose Object >Masking Block” style called 
PlumbBreak. Right Click on this new style and select Set From on the flyout menu. 
Pick the outer bounding polyline then N at the command line to not add another ring. Pick the 
middle of the bounding pline as the insertion point. Pick the two break marks as additional 
graphics. 
3) Go through the create content wizard (Format>AEC Content Wizard).  
Page 1 Select Masking block and then select  PlumbBreak and “Add” it to the content file. 
Page 2 Pick the layer key you want for the automatic layering – ANNOBJ is good. (If you want to 
enable scaling so you can make the masking block vary in size with the plotted size you can do 
this here, but make the original block about 1 inch in size and set the scaling to drawing). 
Page 3 Add a name like PlumbingBreakMark and pick the browse button to put this into your 
content directory – should be out on the office server somewhere – will depend on where the path 
is set in the AEC Content tab of the options dialog box. 
4) Create a new palette and drag the content from the DesignCenter to the new palette 
5) Pick the new tool to add it to the drawing, Select the break mark, R-Click and attach the pipe 
you want to mask.  
 
Notes: 

• At the “Add Another Ring?” prompt - You can have masking blocks that cut a donut out of 
an object if you have a second polyline in the first, or a masking block that cuts two 
separate holes if you have two polylines outside each other. 

• Masking blocks break if you move either the masking block or the object in the Z axis. 
• For some reason all the templates come with the masking block display set as reflected 

Screened even for the plan view configurations. I suspect this is because many of the 
“Architectural Content” Lighting fixtures are masking blocks – I have done some tweeks to 
the block I used to make it behave correctly in the plan view. mainly using the display 
representations to assign layers to the break marks Vs the bounding box itself which I 
have turned off. 

• I will provided the masking blocks I demonstrated as downloads from my web site 
davidddriver.com in the AU_ABS downloads section. 

A Note on the Tool Catalogs / Office Standards: 
A while ago, I posted a long rough draft to the custom files newsgroup. This document is targeted 
for CAD Managers and covers manipulating catalogs - how to go about setting up the catalogs for 
an office so everyone is using the same set of tools from the same catalog source. 
For this document go search the discussion group: 
News://Discussion.autodesk.com/autodesk.aec.arch-desktop.content - the post date is 9/21 and 
my newsgroup name is DdDD. 
To sum this document up: 

• Keep the local tool palettes local – if you path this to the network, it will clog the 
bandwidth and you will have problems if people change the palettes. 

• Create an OfficeCatalog out on the network 
• Create the palettes and tools for the office locally and then and put them in the networked 

catalog 
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• Users add the OfficeCatalog to their Content Browser and drag palettes and tools to the 
local working palette bar. 

Project Navigator 
The Project Navigator to the Xref manager what a computer is to an abacus. Hmmm…kind of like 
the xref manager on steroids, and then some. 
For those new to the 2004 environment, a quick summary:  
There are two parts to the Project management. A Project Browser and a project navigator. 
Project Browser is used to create new projects, copy project structures (just the folder structure 
not the project drawings, and to set projects current (change from one project to another) 
The Project Navigator is the interface you will use the most. There are some terms used here that 
will get in the way of the learning curve. The Project Navigator uses the terms Division, Level, 
Element, Construct, View and Sheet.  
Divisions and levels just provide ways to organize the project horizontally (Divisions) and 
vertically (Levels) 
Elements, Constructs, Views and Sheets really DWG’s, so don’t sweat the terms, just look at it 
this way: 
Create the building model in Constructs. Do the 3D thing here in these drawings. 
Elements are just small parts of a repetitive building model – I cannot think of a good use for 
elements right now in the Building Systems mindframe. You will probably think of some, but you 
can create most projects without using elements 
Create the annotation in Views. Do the 2D things in Views 
Put your tags, keynotes, leaders, notes etc in the view.  
Schematic diagrams, details, are created in empty views. 
The view will arrange the building model for you. 
Sheets are the plot sheets. Dragging a view onto a sheet (paperspace) will create the viewport 
and manage all the xref links for you.  
 
That is the general rule of thumb, but you might want to break it sometimes: 
If make an extra division called 2D. You can use this as a division then when you create your 
views for schematic diagrams and details. This will eliminate a step of having to uncheck all the 
folders the view wizard wants to assign to this view.  
Tags can now tag through the Xref Barrier and can be added at the view level. However, ABS 
Labels still want to exist in the drawing where the object resides (so you will be annotating with 
labels in the construct). 

Working with the ABS objects 
Most of you who have been using ABS for a while now will probably already be familiar with the 
ideas in the following section. I am including it here for those who are just entering the ABS 
realm. 

Adding Parts and Pieces 

Building System Snaps 
Use the nod snap with move, copy etc (standard acad commands) – Although I have been told 
not to do this – that it will break the connection, as long as you know that you are moving parts 
of the same shape, size and system, I have never found it not to break the connection, and now 
that the Buildng osnap toolabar is so buried, I think this is a fine thing. 
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On the topic of snaps – anyone who has worked with ABS for a while knows this behavior – but 
for the newer users I thought I would put this in: 
Duct, Pipe, Cable Tray, Wire and Conduit each have two Building System snaps. One along 
the “curve” (think base line that creates the object) and the other at the end. If you are 
zoomed out, it is difficult to see whether you are picking the end of the curve. – if you pick 
the end, you will get a continuation of the object, if you pick the curve you will get a T 
condition 

  

One way to deal with this is to always pick 
outside the object you are trying to hit the 
end of. This will work in plan, but will not 
always be possible in Iso view 

 

The other place this shows up that is pretty 
critical is on the electrical devices. For the 
functionality to work, the wire must be 
connected to the J-Box, and not the wire 
hidden by the J-box 

 
OK, that is the way it works, so I find that I must have access to isolate the end conditions. There 
are a couple ways to do this. 
1) Keep the osnap>settings>Building system snaps only set to the end conditions, and 
manipulate these settings as you need to. This is OK if you are doing the electrical – just turn off 
the electrical curve connector building osnap, but is not really a productive working method for 
the other disciplines.  
2) Use the Window menu pulldown to add other menus to the workspace. In particular go to 
Windows>Pulldowns>Building Systems 3>MEP Common 3. This will load the BS Common3 menus 
and toolbars. While I don’t really want any of the menu items, there is one toolbar that I want 
from here – and that is the Building Systems Snaps. With this menu loaded you can now get this 
toolbar by either: 
Right Clicking on a grey area of the toolbar area (not on any of the toolbars and follow the path 
on the popup menu BSCOMMON3>Building Systems Snaps. You can also get these after the BS 
Common 3 menu is loaded by typing Customize at the command prompt and turning on this 
toolbar at the toolbar tab. 

 
With the Building Systems snaps up you can “Palletize” these by right clicking on the toolbar, 
selecting customize (or again Customize at the command line). With the customize dialog box 
open – doesn’t matter which tab is active, the customize box just needs to be open – just left 
drag the tool icon onto a handy palette. – useful to add the duct and duct curve connector to the 
duct palette etc. 
If you are a keyboard person the building snaps at the command line are as follows: 

Schematic Curve Snap: SCUR Schematic Connector Snap: SCON 

Duct Curve Snap: DCUR Duct Connector Snap: DCON 

Pipe Curve Snap: PCUR Pipe Connector Snap: PCON 

Electrical Curve Snap: ECUR Electrical Connector Snap: ECON 

Wire Way Curve Snap: WCUR Wire Way Connector Snap: WCON 
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More Adding… 
Adding and the Compass, and Osnap and Otrack and Polar… 

 

When you are adding pipe etc. be careful with the 
use of the compass combined with direct data entry 
for distances. The picture at left shows adding a pipe 
with polar off, ortho off. With the cursor in this 
positions, typing in 10’ gives a pipe length of 
9’6”because the compass simply records the x value 
of the cursor, or the length of the line in the 
direction the compass is pointing. 

 

 

Working with Polar turned on will allow you to stray 
away from the compass, and as long as the polar 
track shows up, you will get a 10’ pipe. 

Ortho does the same thing, but does anyone use 
Ortho now that they have polar tracking? 

 

Otrack 

Something changed between Release 2 and 3 that allowed the plan view of the ABS objects to be 
a lot nicer (meaning that if you ID any point on an ABS object you will get a Z value of 0). This 
means that you can use otrack in plan view to get what you want. If you cannot otrack between 
two ducts/pipes/cable trays that are on different elevations, check to see that in plan view all z 
values are 0. Otrack does not like to track between different Z values. 
 

Use Quick select to grab things. 

Quick Select has been around for a while, and in my classes I see more people familiar and using 
it, but still amazed by how many people still are looking for old solutions to do just part of what 
you can do with quick select and the properties page. – need to change all the 6-8 VAV boxes in 
the drawing to 6-6’s? – quick select the entire drawing, filter for the size name, Right Click MvPart 
Modify and pick a new size… 
Change all the tags to a new size? – Quick select MvBlocks by layer or definition name. 
 

Working with vertical rectangular elements – Duct and Cable Trays. 

When you are working in plan view, adding Horizontal Ducts the width and height make sense. If 
you start with a vertical run say 24x12 and then turn horizontal in the narrow axis, you used to 
get a duct with a normal with Y=1 which means that the width and height may be reversed. 2004 
does a MUCH better job at maintaining the normal Z=1, but you will still find these kind of 
ducts/cable trays in drawing from previous versions. Adding a duct to this duct will compound the 
problem. If you are adding a horizontal duct/cable tray and find the width and height reversed 
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from what you expect, go to the duct duct/cable tray properties page and look at what the normal 
is set to. If it is not z=1 you might have a better time just redrawing that section of the system. 

• Always connect to a vertically oriented duct connector on an MvPart – rather than starting 
the duct on the part and then rising vertically and turning horizontally 

• As you are connecting to a vertical run, change the shape of the horizontal duct before you 
connect to the vertical piece if the two sizes are similar. 

• Remember you can always make a custom fitting for the vertical piece. 

Working in cramped quarters 

Use Live Section to isolate a smaller portion of a complex system 
From the annotation tab, use the section mark tool 
Pick two points in the drawing and answer Y to create AEC Section Object 
Grip stretch the bounding box (the Section Object) to cover just what you want to work with. 
Select the bounding box (not the bubble or tail) and R-Click “Enable live section” 
Swing into an iso view and voila you can now work on just a portion of the system without the 
rest getting in the way. 
 

Make the ADT object flat in model view 

Use the display manager to create a new configuration that shows only the plan representation of 
the ADT objects so that the walls, doors, windows etc. are not cluttering up the iso view. 
1) In the display manager, in a new ABS template, right click on ABS Model set and select New. 
Right clicking new on an existing set or configuration will copy the configuration and all it’s 
settings 
2) Rename this Display Configuration to ABS_FlatArchModel. 
3) Scroll down the list – anywhere there is a check in the Model Screened, uncheck it and check 
Plan Screened instead. 
4) Expand the configurations, select ABS Floor, R-Click new and rename the new configuration to 
ABS_FlatArch. 
5) set the default display set to ABS_FlatArch 
You now can assign this display configuration to any viewport and the architectural portions 
should be shown in 2D when viewed in iso. Exceptions to this are the Roof, Roof Slab, Floor Slab, 
Mass group, and structural objects which don’t have nice plan representations. 

Frozen layers and “last used settings” 

This is just an Oddity. If you are creating objects on top of other objects – 
duct/pipe/cabletray/conduit you may come across this. You draw a run of duct - say return duct. 
And now you want to draw a supply duct at a higher elevation. You freeze the layer of the return 
duct system. Now you launch the add duct command, change the system to supply, and then 
start adding the duct. Low and behold the duct is connecting to a “frozen” duct layer.  
What is happening is this. The last used settings of the duct add dialog box are tripping you up. If 
a layer is frozen, but is needed when you add a duct the add-duct command will unfreeze the 
layer it needs to put the duct on. The last used settings are return, and so when you launch the 
add-duct command this return layer is now unfrozen. It is not displayed because there have been 
no regens, but nevertheless, it is no long frozen. Even though you now set the system to Supply,   
it will activate the duct curve osnap on the return duct that is invisible below the point you are 
picking.  

More on Nodes 

Sometimes I find it easier to place a few nodes in the drawing and play connect-the-dots with the 
pipe, cable tray or duct. I do this if I cannot get the Suggested Layout to work, or if I need 
absolute points where the object must be placed. Use the point command to place points in the 
drawing where you want the run to have a fitting. Change pdmode to something like 35 so you 
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can see them. Set the osnap to node. Turn off the compass and connect the dots. Use quick 
select to grab all the points and delete them. 
 
 

Exporting ABS drawings 

In release 3.3, when you wanted to get a drawing to a consultant you went to the explode AEC 
objects command or came up with some script function for the AECObjExplode command. With 
2004, on the file pulldown you export to… 2000 or 2004 format. At the core of this command is 
still the AECObjExplode, but you don’t have so much control over what it does. *You can still use 
the AECObjExplode command in scripts or as a command line entry.* 
If you export to AutoCAD and things get out of place … 
I have noticed this behavior on drawings created in previous versions – the Export functions 
places all your MvBlocks on layer 0 and at the origin… 
From what I can tell – this is because a module is not loading properly (admittedly I have hacked 
my registry so that I don’t load all ARX’s at startup). All the ARX’s need to be loaded so that the 
export function can work.  
You can always go back to the aecobjexplode command – type this at the command line and use 
this instead, be sure to saveas to a different drawing name first – I will put a script into the AU 
downloads that will change to the model view, world UCS, run the objects explode then change 
everything to ByLayer. – you can use this as a script, or put it into a toolbar button. 
 

Integrating and Implementing 
This section just presents some general ideas on thinking with the ABS package and integrating 
ABS into the office. 

Object(ive) Philosophy 101 

I have hear from my student and seen out on the newsgroup the idea that People don’t like this 
package because they have the idea that it forces the design up front, or forces the drafting staff 
to have to know exactly what parts will be in the final system. I have two responses to that. 
1) Working with Objects (as opposed to ACAD entities lines arcs etc) is a different paradigm. The 
idea with objects is that you can put the objects in the drawing and then modify them as the 
design evolves to be what you want them to be. So you don’t know exactly what size VAV unit is 
going into the space – fine just put a 10 inch in there and let it be a placeholder until you do your 
sizing. Once the sizing is done, and it is determined that it will be a 8 inch, select the VAV and 
Right Click Mvpart Modify and change it to a different size. You have to be aware that this will 
change the connector heights on the VAV unit, but with this in mind, you might just want to use 
lines as a temporary link between your duct runs and the Duct Connectors on the VAV. 
2) Use the Undefined Parts   - Pipes, and ducts both have an Undefined part type that will display 
only as a single line. Again, I would not bother connecting these to my MvParts until the design is 
done. 
3) Don’t be afraid of recreating some things as the design changes. Sometimes it is easier to 
redraw a section and it is to try to modify what is there. With the Suggested Layout options, 
sometimes it is easiest to simply erase the pipes from point a to point b and then add a new 
section that it is to stretch and move things around in 3D. 
4) Don’t hesitate to use what tools you have available. If the schematic symbol for a supply 
diffuser works better than the MvPart, use it. You are still in the ACAD environment. You still have 
lines and polylines to work with. As you make these decisions, you have to ask “what am I 
sacrificing to by doing this?” in this case, you give up the ability to tag the ceiling diffuser as the 
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tags want to look to a MvPart, not a Schematic Symbol – but you can tweek the tags to use the 
symbol instead. 
5) My personal philosophy is this is just a set of tools. If the tool works for you, use it, if not, 
don’t. For every tool, I have to ask myself, is modeling helping me of hindering. Where does 
modeling get in the way of getting the drawings out the door? For most of the objects you have 
to understand the object well before you can make this decision. Continuing from the example at 
number 4 – you might at first say well the schematic symbol does what I want it to do but I 
cannot use a tag on it – not until you understand the tag tools and see that you can tag a 
schematic symbol can you really make the informed decision about how you want to use the set 
of tools provided in ABS.  
 

Implementing ideas 

Make a Mock-Up Model 
When you make the jump into ABS you are tackling a paradigm shift from AutoCAD lines arcs and 
circles to building system objects. Your office has a process. ABS and the object paradigm has a 
process. The melding of your office process that is based in lines arcs and circles to the object 
oriented process should be thought out before you jump with the whole office into this new way 
of working. From the note above, the CAD leads need to understand to a good degree the 
functionality of the tools in the toolkit. I strongly suggest training for a CAD lead group.   
Once the CAD lead group has a good handle on the tools and their functions create a model 
mockup. Take a portion of a completed project and create every sheet in the final CD package for 
that small portion of the building. If possible, make it at least a two story project so you can work 
out the project navigator issues as well. 
The purpose of this mock up is to asses the impact of any particular tool to the office process. The 
mockup is essentially a decision making tool. You will be forced to get the systems worked out – 
how you want them displayed, whether you are going to use one line or two line. Whether you 
are going to use the Excel Panel schedules or the panel schedules inside ABS. How are you going 
to set up your projects in the project navigator? Do you have all the display representations you 
need? Do you have the parts you generally need for the building types your office works with? 
If you do this for a small portion of a project you will answer these questions before you are half 
way into a paying job and realize you need to revise your working methods/Styles or systems 
blowing the budget and making your boss angry. 
One more note: - do not assign this task to one person. Make this the responsibility of a CAD 
leads group. Even if you are a small firm I suggest that you have a minimum of three people in 
this group. I say this for several reasons. Beyond the obvious - that if that one person leaves, 
you’re out of luck – having  a group do the mockup will allow the distribution of non billable hours 
over more employees. It will allow you to resolve more issues concerning the melding of your 
office process and the ABS process. 

Start in 2D, add new functionality incrementally 
Another Idea is from the kids joke – how do you eat an elephant? – one bite at a time. 
For the first few projects just use ABS in 2D. While I understand that yes there are elevations and 
all the dialog boxes want 3D information, but there is NOTHING to keep you from using most of 
the tools as 2D tools – just don’t ever view them in an isometric view or use the orbit. Once the 
staff gets used to working with objects, add tags and schedules. Once those are familiar, then go 
ahead and introduce working in 3D and using rise and run and all the other goodies like live 
section and 2D sections. Again introduce the goodies a bite a time. Keeps the head from 
exploding. 
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Parts and pieces, Catalogs and Catalogs. 
This section of groups together some more very random thoughts about using the parts and 
pieces of the ABS Tool kit. This sections kips around a bit because of the amount of tools, parts 
and pieces you have available 
 

Annotation Items – labels and tags… 

Labels: 
Label text height is determined by the height setting of the ACAD text style assigned to the label 
curve style.  

 
This works just like text assigned to a dimension style. If the ACAD text style has a height 
assigned to it – it will use that height absolutely. If the height assigned to the ACAD text style is 0 
then it will look to the parent object (in this case the object Label) to determine its height. Labels 
use the drawing annotation scale factor to determine the text height of the label. 

Drawing Setup, Scale and Annotation Scale 

Drawing setup has been moved to an innocuous little circle and arrow at the lower left hand side 
of the screen. Drawing Setup has two scale factors Drawing scale (really dimscale) and 
Annotation Plot Size. Content can use no scaling, drawing scale, or the annotation plot size scale.  
They work in tandem like this:  If you create your content annotation text 1” tall.     
Set the drawing scale to what you will print the sheet at, for example, ¼”.  The drawing scale will 
always be applied to content created with the annotation scaling flag set. At this point the text is 
now multiplied by what ever factor this is (48) to be plotted at ¼” so your text is now 48 inches 
tall. If you just use Drawing scaling, and not Annotation that is the end of the story.  The text is 
plotted out and appears 1” tall on the print. If you select Annotation scaling, the content (text is 
multiplied by the annotation scale - let’s use 3/32” in this example.  So, the 48” tall text is now 
multiplied by 3/32.   3/32 x 48 = 4.5 the proper size for text to be plotted at ¼”=1’-0” to appear 
3/32” high. 

Tags 
While ABS Labels are fine – their core functionality is entirely different than a tag. They were 
created for the ABS objects and work well with those objects. Despite, or perhaps because of 
their focused nature they are a bit limited in what they can do. Sometimes using a tag is better at 
getting the job done. Tags themselves are more generic and can be applied to any ACAD, ADT or 
ABS object. With 2004, the functionality of the tags grew by leaps and bounds. Not only can you 
manipulate formulas in your tags, but you can link the project levels and do many other neat 
tricks as well. 
 
While ABS provides many schedules and tags, there are some tricks that I find useful to add to 
compliment the tags provided. When you are working with schedules and tags, keep in mind that 
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the tag itself was probably created to work with a specific schedule. Not all tags for an object will 
attach all the property set definitions needed for all schedules for that object. 
 
There are three parts to a tag: an MultiViewBlock, an ACAD block with a special attribute format 
and a Dictionary that controls what happens when the tag is dragged from the DesignCenter. The 
MvBlock is just an ordinary MvBlock *You can burry different size ACAD blocks and use display 
control to get a block that resizes itself depending on the Display configuration* The ACAD block 
is just a standard AutoCAD block. The attribute in the ACAD block has a unique format that is 
<PropertySetDefinition:Property>. Anything that can be put into a Property Set Definition as an 
individual property can be displayed in the tag – and that list is a long one. 
The Dictionary is everything on the three pages of the Create Content Wizard. This dictionary 
stored in the drawing controls what happens when you drag content into your drawing from the 
DesignCenter. Part of the dictionary stored in a tag is a custom command that is launched when 
the tag is dragged into a drawing. The command _AecAnnoScheduleTagAdd creates a relationship 
between the MvBlock that is the tag and the object that is being tagged. This command also 
attaches the PropertySetDefinition to the object you are tagging. This is one of the reasons that 
the tag and the schedule are usually created to be used together. The property set used by the 
tag and the property sets used by the schedule should be the same. But you can create 
PropertySetDefinitions that are used just for tagging and do not show up in any schedule. Each of 
these parts, MvBlock, Tag/PropertySet, and Dictionary have some say in how the final tag 
appears in the drawing. 
 
Annotation in Tags. 
The tags provided with the install do not adjust their annotation automatically. While this is fine 
for most firms you do have control over how the text in the tags is handled. The Dictionary 
controls if the annotation is set to the current text style, or is defined by content. All of the tags I 
have seen in the package disable this feature by not including the standard ACAD block in the 
contents dictionary. If you add the ACAD block then you will have access to setting the tag to be 
controlled by the current drawing’s current text style. This can all be changed for existing content 
by right clicking on the content in the design Center and selecting Edit from the right click pup-up 
menu. This will lauch the content wizard an allow you to make changes to how the content 
behaves as it is added to the drawing. 
Currently, all the tags are set up to just add the MvBlock to the target drawing –while this will 
bring in the ACAD block as well what you see on the next page is determined by what happens on 
the first. If you add the block on the first page, then you will get control over how the text is 
handled on the second. 

    
 
If you set the Attribute text style in the dictionary to Target Drawing Text style, whatever the 
current text style in the drawing is will be place in the tag.  
The Second part of text control how the raw value from the property is formatted. If the tag 
displays a number, is it displayed as 20” or 1’-8”? If the property is text, is it displayed as upper 
case, title case or all caps? This function – formatting text is handled by the same mechanism 
that formats the values in the schedule – the Schedule Table Format style.  
Each Property in a PropertySetDefinition, is assigned a format style that controls how the raw 
value of the property is displayed in the drawing. Generally this is set to upper case. If you need 
title case or lower case text in a tag you will need to modify the Schedule data format used by the 
tag. 
1) Select the “tagged”object and look at the extended data tab of the properties flyout 
2) Find the property that you want to put lower case in 



 Inside Scoop: Autodesk® Building Systems Tips and Tricks 

 

   13
    

 

 
The Extended Data tab lists the property and the property set definition 
3) Use style manager to open the property set definition and find out what format style is being 
used. Assign Case AsIs if it is available. 

      
You may need to create a format style to do this – just cerate a new schedule data format style 
and assign Text Case to AsIs 
There are many Schedule data Format styles created already in the AECB Schedule Table 
Drawing.dwg that you can import and use from the style manager. 
 

 
 

Level based Tags. 
New to 2004 is the ability to utilize the project navigator to establish the levels of the building. 
While there are some project-based door and room tags there are no project based ABS tags that 
I have found so far. It is fairly easy to create level based tags. 
 
Make a tag your own. 
Use an existing tag as a template. I usually create new tags by opening a tag and saving as 
something else. This copies the dictionary and the custom command so I don’t have to deal with 
that part. 
Copy Existing tag 
1) Open the DesignCenter  
2) Find the Documentation>Schedule Tags>HVAC tags 
3) Right click on the VAV tag 4, select Open. Saveas AU_ProjectWSHP_Tag.dwg  into the same 
folder where you got it. 
Create a property set that is unique and make the properties that you will use in the tag. 
1) Open the Style Manager and expand Documentation Objects, select the Property Set 
Definitions and R-Click New. 
2) Double click the new style to edit it. 
3) On the general tab, give it a name like ProjectWSHP – no spaces because this name will be 
used in the attribute of the tag. Give it a description – be nice, someone else in the office may be 
using or trouble shooting this tag, let them know why you created it and in what version. 



Inside Scoop: Autodesk® Building Systems Tips and Tricks 

14   

4) On the Applies To tab, pick the objects radio button, and then select clear all at the bottom of 
the dialog box. Put a check in the MvPart box. 

          
5) On the Definitions tab, pick the Add Project Property Definition button on the left.   Set the 
name to LevelID and put a check on the Level ID line. At the bottom of the dialog box, choose 
Case Upper as the format. (this is the schedule data format style). 
 
6) Pick the Add Manual Property Definition button. Name this Item and use the drop down to start 
with MvParts-Object:tag. 
At the bottom of the dialog box, change the description to Item Name, leave Type as Text, enter 
WSHP for the default value and change the format to Case-Upper. (starting with a default will fill 
in these lower values. 
7) Pick the Add Manual Property Definition button. Give it the name “Number” and start with Item 
that you just created. 
8) Change the type to Auto-Increment Integer 
9) Pick the Add Formula Property Definition button. Give this the name TagID. In the lower 
portion of this dialog box, expand the ProjectWSHP property set if not already expanded. 
10) pick the properties in the following order LevelID, Item, Number. It should look like this: 

Pick OK back to the drawing and save. 
 
Change the Block and MvBlock definition names 
It is important to make both the block and the MvBlock names unique so that if you use the 
original tag in the same drawing there will be no conflicts. 
1) Enter RENAME at the command line. Select Blocks on the left and Aecb_VAV_Tag_G on the 
right. Type in AUWSHP_Tag_G in the new name field and pick the Rename to button and the OK 
button. 
2) Open the style manager again and find the AECb_VAV_Tag_4 MvBlock in the multipurpose 
objects. Double click to edit it. On the General tab rename it to AUWSHP_MvTag (just replace the 
existing name). On the View blocks tab make sure that AUWSHP_Tag_G shows up as the view 
block. Pick OK, OK to get back to the drawing. 
 
Redefine the block attribute 
1) Enter REFEDIT at the command line and select the block that is in the drawing. On the settings 
tab make sure that “Display Attribute definitions for Editing” is selected. Pick OK 
2) Double click the attribute to bring up the edit attributes dialog box. 
3) Replace MVPARTS-VAVOBJECTS:TAG with ProjectWSHP:TagID. This is the magic behind the 
tag the attribute must be in the format <PropertySetDef:Property> 
4) Refclose at the command line and save, or pick the save changes icon on the refedit toolbar. 
5) Erase the block that is there in the drawing and insert another instance of AUWSHP_Tag_G at 
0,0. You will use this later for the preview icon. 
 
Redefine the drawings dictionary with the AEC Content Wizard 
1) From the Format menu select AEC Content Wizard. Very the content type is Custom Command. 
2) On the left select one at a time the AUWSHP_MvTag and the AUWSHP_Tag_G and pick the add 
button.  
3)Pick the expand button 
Carefully replace “VAV Tag 4.dwg” with “AU_ProjectWSHP_Tag.dwg” – this is the name of the 
drawing where ABS will look for the property set definition if it does not find it in the target 
drawing. So you are telling it to look in the drawing the tag is sourced from. 
Carefully replace Aecb_VAV_Tag_4 with AUWSHP_MvTag. This is the name of the MvBlock you 
want to tag with. 



 Inside Scoop: Autodesk® Building Systems Tips and Tricks 

 

   15
    

 

I say Carefully with both of these because if you mistype, or delete or add a space, the tag will 
not work.  
What you are doing is providing all the replies to the command line prompts/options as if you had 
typed "AU_ProjectWSHP_Tag.dwg" at the command line. 

Side notes – you can only do one command here, you can not script. You can however, put 
a lisp function call here. A list of the ABS command can be had by typing ARX at the 
command line and then C for commands. This is a long list and you might want to turn on 
your log file and capture this  - or just email me an request it, I have it somewhere in a 
word doc. 

4) Pick the Next button to get to the next page of the wizard. Because you started with a tag, all 
of this should be fine. This is just read out of the dictionary from the original tag we started with. 
(be careful with enable AEC unit scaling. This drawing  
5) pick the next button to get to the last page. Here, pick the current drawing box and then the 
Default Icon button and then Finish. Save and close the drawing 
If you are already open to this folder of the DesignCenter you will have to pick on any other folder 
and then pick back into the HVAC tags folder. 
I have included this tag in the AU Project Data Files download. 
  

Isometric Schematic Diagrams and Isometric Symbols 

1) Always use the iso orientation you want the labels to use on that line segment 
2) If you create your own Isometric symbols realize that you will need to create blocks that work 
for each of the specific Iso modes left, top, and right. Many symbols you will just need to create a 
subset of these – such as for a WC trap – a WC trap need only be created to apply to either a left 
or right mode iso line that is in the vertical orientation (unless you wanted to create one symbol 
for a double water closet back to back and apply this symbol to the horizontal run…)  
 

 

As noted in the help file – to fully create an Iso 
schematic symbol that could be used in all cases – 
maybe a cleanout would be used in any orientation – 
you would need to create a total of 12 blocks – left right 
up and down for each of the iso modes, left right and 
top. Well we’ll get to that. 

 

More realistically, most parts are either going to be 
inserted on a vertical or a horizontal. If the part is going 
to be on a vertical, you only need to think about the left 
and right orientations, and usually one set of 4 blocks 
will take care of this. 
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Each individual block is assigned not only to a specific 
iso mode, but a specific Iso Rotation as well. You can 
see the iso rotation in effect when you add an iso 
symbol to the drawing, you are presented with only four 
choices of how to place the block – these are the iso 
rotations you specify for the blocks. Don’t sweat the 
terminology – just assign four blocks to the iso left 
mode and keep track of which you have already 
assigned. In this case the Left Top block would be 
assigned to the up and the Right Bottom to Down 
rotation. The Right Top block to right rotation and the 
Left Bottom to left rotation – repeat adding the same 
blocks to the right iso mode 

 

When it gets to the schematic blocks that will be on a 
horizontal, you need to create different schematic 
blocks for different conditions. For instance, you will not 
be able to have a schematic fixture that will have both a 
horizontal and a vertical orientation along a horizontal 
line. The example at left shows that no matter what the 
Iso Mode is, this kind of block would want 6 rotation 
blocks – ain’t gonna happen. – you could make an 
“Upstream” and “Downstream” Y, or Left Y, RightY 

 

  

   

Make several different Schematic Symbols that each do 
different things. The diagram at left shows a Y with 8 
blocks would take care of both flow directions. As long 
as the block was only added to the left or right iso 
modes. Once the block was added to the top iso mode 
there would need to be 8 more blocks added to the Top 
Iso mode so the whole thing falls apart I would make 
two Schematic parts. The first being a RightHorizontalY, 
the second a LeftHorizontalY, and then I would make a 
Vertical Y as a separate part. 

So the long and short is plan your Iso Schematic blocks fully before you start making the parts. I 
have not made these parts, but if someone is interested, email me. 
 
Schematic Symbols and Electrical Devices 
 
When you are working in style manager on schematic symbol definitions or Device styles be 
careful in the views tab of these definitions  
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just picking the cursor in the Display Representation or changing the check boxes in the view 
directions will change how the device or symbol shows up in the drawing. There are no dialog 
boxes that jump up and tell you not to do this, so I am doing it here. The diagram above shows 
that when the display configuration calls for the model representation and the view direction is 
anything other than top or bottom, then show the view block AECBE_FLSB_24x48_M. Picking Plan 
on the middle left would assign the Plan configuration to this block – and the block would 
disappear from any model view. 
Devices will not show circuiting information until you set the system type to Power and Lighting 
on the connectors tab. 

Content and Content Builder: 

Block Based MvParts 
Build Mvparts with dwgs from the manufacture – many manufactures already have CAD drawings 
you can download from their websites.  

• Rotate the side blocks in 3D so that the orientations are how they would appear in the 
world. To use 3D rotate, remember the right hand rule. Put your thumb in the direction of 
the axis you are rotating around and then your fingers will curl in the positive rotation 
direction. 

• Explode the blocks and then make blocks in the proper orientation using a common base 
point for all side blocks. 

• If you need the part to hide things behind it you will need to add regions to these blocks. 
Use the Bpoly command to quickly generate regions. 

• For the model view, make a rectangle and extrude it (EXTRUDE at the command line), 
then make a block out of the resulting solid 

Yes, it is simplistic, but yes it’s done and it works…. 
 
Working with ABS Parts Catalogs 
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• Invest in a good xml editor – xmlspy makes two versions, I use the pro version – if anyone 
is using the home version successfully with ABS let me know, you could save 250 bucks. 
Both versions have 30 day trial periods. http://www.altova.com/  

• When you are working with the catalogs themselves, use the catalog editor provided with 
ABS. Each Catalog has a GUID – or unique identifier. Do not just copy and past catalogs 
with windows explorer. 

• You cannot have more than one catalog open at a time, but there is nothing to keep you 
from having two sessions of the catalog editor open side by side if you need to reference, 
or copy and past values from catalog to catalog. 

• When you are working with the parts – then yes you can just move parts around. When 
you regenerate the catalog it should find all parts below the catalog and display them if 
they are complete and are not flagged as invisible. The Catalog should rewrite the XML of 
the part to find the new locations of the bitmap and dwg. – Use this if you want to move 
parts onto the network, move part to a new installation, or simply migrate parts that you 
created in the last build and are moving forward into this one. 

• If you can use a part that exists that is similar, use the catalog editor to copy the part and 
make changes. An example of this is the 1.5 radius elbow for the Mechanical duct. Many 
firms have asked for a .75 radius elbow. This is a simple part to make and as a matter of 
fact the tutorial shows how to do this (they show how to make a 2x radius because I show 
how to make a .75 radius in my book (?)) 

 
Parametric parts 
Keep your parts simple – creating a duct silencer that has the baffles in place is a challenge that 
is not worth the time. Creating a duct silencer that is a stupid looking box is fairly painless and 
works just as well. Keep the graphics for the schematic block representation. 
 
Make a few generic parametric parts and then use them as templates. You can go ahead and 
create the model of the part, but keep the connectors off as that will limit what type of part you 
will end up with. Keep the generic parts in a separate catalog until needed. Set up separate  List, 
Table type generic parts. This is the type set in the size parameters. A variable can be a 
calculation, a constant an list or a table. Most simple parts are going to be either a list (all even 
integers between 10 and  120) or a table (36, 45, 60, 90) an isolated group of integers. Table 
base parameters are those you find in parts that just come in a limited set of sizes and the X 
values are not cross listed with the Y values when you add the part (Modular coil units). List type 
parameters are used parts where you can have any number of combinations between the X and Y 
parameters (Reduction fittings).  
Remember for list variables you can copy the list (that 1- 100 size list) into excel and then paste 
it into your part 
 
That’s it for now, good luck and Happy BIMMING! 
 
Other resources: 
I don’t mean to short anyone out there, but Marinsoft is the only company I know of that 
produces add ons for Building Systems – If you or your company are creating add-ons for ABS, 
drop me an email and I will link to your site from mine.  
Knowledge base – go there 
Discussion Groups – you will find quite a few talented people on the ABS newsgroup both helping 
each other out and telling it like it is. 
 
My Resources 
www.davidddriver.com 
AU@davidddriver.com 


